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sruuAaMATIvUINsIUUTINAUEmzgneanuuulngfun1snseaedeyauuy many-
to-many fedaweundiaduiivh MQTT Widetaunswaneasaguillivu 10T Platform 713
aglurosmanmuinuneg uarouniiil 10T Platform sgnatusniduneniin MQTT Aléfigat
medlagnisgnurluldiu Facebook Messenger Fremeiiosiainlndusidonsenionly
N3l uUsnIslegdudiu loT vuAanIn Savadufuiinsiu Network Engineer 11n#iag
81910 device anmnsaviinisaiig session wandsudeyatulilnslidosiinisde
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Wy wonndnduiildaufie Facebook Messenger
aeAUsENEUTEY MQTT Protocol Usznaulufessil Insasvhmdhiluansnaiu
1. Broker it udanarsdlunisivdedeyasening Client wiodanisiy
Famaulag $198997n Topic laeii3sn1sadeidunis (Routing) saawade (Topic) laedl
Client Fasvims Subscribe Tu Topic fisfiasioanis 9ty Broker fazdstayaismuaiign

1
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Publish Tu Topic duql Taeft Client Aeansfulnedlaisintu Fadedudafidesosnsvens
wietsfaunsadndunislding wasuihiifiddauindnegisuas broker Aa¥nwininy
Uaonfoveaaiatny Wi n13vi Authorization waz AUthentication 283 Client @9
2. Publisher agtimihiinoadstayaludaidat q
3. Subscriber $1¥ 11Tl Anagn1sIUBeuLUa98I message 1167148 9
¢8 Topic L fhﬁﬁa*ﬁawﬂﬂau’lmmzﬁmiLU?{wuﬂaaﬁ%ﬁwmﬁ&%’a;&aﬁu 9 wlganu
Client @3t Publisher n3a Subscriber w58 Publisher/Subscriber luiaan

=

ey i Client azdeaduaynsalfiaiunsadu MQTT Client Library Ut TCP/P 1é@as

3
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a s 1

Library tovazdauinianfinasitaldlanualnsalafintweansdadn wsaznasldluma
Publisher/Subscriber Tun1fiAnAIuIMIzanNanlUS Broker LazTopic Aoazidu
= = R =i '4 o o 1 A W [ 1
willou address w38 endpoint YU Broker # client 1N ¥ausae sUd1aA 1158914

o

N

2.2 YAAIUAY
2.2.1 lulasnaulnsataas STM32 Nucle

va$n STM32 Nucleo tluupinlulasreulniaainszna ARM au1m 32 bit veq
U3¥N STMicroelectronics ymauvesuasn Nucleo Aolalunisimuisguuunaniesy
mbed d1w3uuninnszna ARM Cortex-M 983U5E ARM rulusunsuuuntinniulesd mbed
fidaunsaairidununiedmanulnonisidou maudly vienistufinldalsunsuri
Fules wdannanlusunsuluiivadalalnensdaglifesiadslsunsudmdunmataun
vursyimesiag vililddeadsnalunisanilluasniedmenl Usunsulunisimun was
lsiffesteiudioavaviveslusunsudnie sauviesuuvumadeuldmdunie ¢/Cr+ Tadu
mwiFeudidnlalding damuadesiifiasssgndidniunusie WWidusdsfmmnzdmsu
finususuidesnisldaululasaoulnsatass 32 dnvdefldauhludidesnisitamuiuy

wnaaasUNITIUELazaEAINTIALGE



Ui 2.3 uansuasalulasmeulnsaiaes STM32F7672)

yadn Nucleo duaogu WlFlMdenAmnganiuiuiug Tasluamuidod
Fonld uasa Nucleo u F76771 dadnaglunguuainusyansnmga 1 MCU mszga ARM
Cortex-M7 LU85 STM32F767ZI @113152 216 MHz Mu8A U3 navIuIe 2 Mbytes
NULANUIIUTUIUIA 512 Kbytes

dautsznauvassiauasn Nucleo usniliu 2 douinsil

1. daulusunsu ST link v2 1ddmiulusunsy MCU vuvasmdousadifu
AaufimasIuNesH USB vialdidudruredlusunsulvifuuasadu q tneld Pin Header #i
agAuTN

2. vofnlulasaoulnsaiaed STM32F767Z1 vrwng senuuuselianunsald

U Shield va4 Arduino 16 Inewivaedady Pin Header A1ud14983ue5n

2.2.2 Wsunsu STM32CubeMX
STM32CubeMX #o TUsunsuaieaiiofivaslunisimunnisiieg lunis
Feulusunsy Tneanslusinsmiinues ARM Cortex Tugusnauiteliisanusadmunnns
auvedlalasreulnataesliitnulusuuuusieqlé Wy UART, SPI, I/O, RTC, ADC,
DAC Wugu Taeslusunsuasvinisadralndluswatuanly aelulndduasilAnlusunsud
15N AIMUANITYNLTEY STM32 daeTusunsy STM32CubeMX wiliuda Taediisily

soudsiaiuniinislioulusunsuliiu STM32 e antusiiaunsaussynaldsunsula



Fslusunsuduagagnneld HAL Driver yuiugruvesniw C llundn wazianunsaiden
Weulusunsuuu Software IAR %30 KEIL way STM32CubeMX LU generate code
dmiuaiie source code Woldeusauiu Library STM32CubeFs Jafiu Library d w3y
PaeliideTusunsuarunn MCU 1#ieTu Sazadneq MPLAB Harmony framework 84
Microchip wag STM32CubeMX \ulusunsuflaiunsasaely initialize Peripheral &3y
STM32 Idnjudaus FO 9sits LO fuiaemiauviadall driver Wialdaiu Peripheral lhetu
ﬁqg‘uﬁ 2.5

& STMRCube Urtitied - a x

Fhe Frajert Wostim Hiep

Henun &8 75 2 Aoox

New Project
Load Project

Help

sUfl 2.4 uanmthaneadlusunga STM32CubeNx

S5 windotrs

.-smaacubeux E osX'
?E Y

L — -

— 0 itialization code

& TiAkercLUB

Examples and demos

Widdleware components
Hardware abstraction layer

Nt 1. OS X s a rademark of Appla Isc. ragistered h fha U5, and other coumies.

U 2.5 uansnis Initialize Peripheral dm¥u STM32CubeMX lédvngusiaus FO asdia LO
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2.2.2.1 33ms5kU STM32CubeMX
n15199714 STM32CubeMX STM32CubeF4 311U SWASTM32
Library #sluunarnuiazuansfiagranishdain STM32CubeMX Tnenisasne code Fuan
wazinlUld sy SWASTM32 w3a System Workbench for STM32 @aiiu Free IDE ua
Compiler 41§y STM32 Tnsfa IDE 9xad19u197n Eclipse F99zadng iU MPLAB X 494
Microchip Lianlderufrsudisaznaniniizdl Auto complete T 11aLs15en structure

#1499 @11 Compiler AU GCC dmsu STM32

_ é
e g Loy : 4 3 1\,,»:«,‘;?%

U 2.6 uansnslfaru STM32CubeMX STM32CubeFd sauifu SWASTM32 Library

£

n131497u STM32CubeMX STM32CubeF4 $9uAU SWASTM32 fisiall
1. JunpunsnAosnuinaalnaa1 I uRanIULABLNILADS

(AosadipsauInnoudsaulvante)

TM32 MX
TM32 Fa
SWASTM32

JAVA Runtime Environment
@ = & &1 a v v g Y E2g va o ¢ o
ndnaulnanlndd1sgndesldiaianda Aludndslwanvunasuy
ADUNIEDT WALUalUswnsy STM32CubeMX Tuu1 WaIAaNY File -> New Project 1dan

w3 Microcontroller aglglulusianwarnan OK



gﬂﬁ 2.7 wansn@ng New Project Tusunsa STM32CubeMX

| & HewProjea x
MO Seecttr Board Selector
MCU Fiters:
Series : Lines : Padage :
ST v smuFEaTA v [ - MosFRen
MCUS List: 16 Ltems:
o Loz
L0 s STOZOTER  SMIEeA0
i3 EMaOnE STOFERIAL
10 cnerenes  sweEwiAn
5 | [heEene sverwAn L
o B
3 T 5 STMIERTAIT
P i 10l SIMIFNIGIx  BIMIFNTALT
(@ 'E ST ETMIF 0717
-II | STMIZF4LNETx STHIF07/M417
(@FSC |0 STM3FAUIGH:  STMIZE®7/A17
3 E STHIFITAG:  STMIFNTAT
e I L
1= I SMEanTs  EMIFATAD
@) = ETMIFATET:  STOFENTAL
ol T T STMIFRTGTx STMIFDIAL
3 O
9] [
LIS SRS
El im|
(i =
O =)
@ 10 =]
) |
I 3 Sl
o= 0
) g
_ e v v
o Caneal

11

o & L il Ve 1 & ° '
2 wdsndulssadelusian fepsunusliawesvadllnnaLasiwmidamasas

STM32CubeF4 (?haﬁi’mﬁdgﬂ 19 Uncheck p53ee Generate Under Root 8annae

3
il

U

#

Project  Code Geperalor  Advanced Setings
Project Setings
Propect Name

| e

Project Locaton

DAENSTMI2Cube FW.FA_VI 14.0Propects

Toolchain Folder Locabon

Y

DrlstiSTMIZC S FW_F4_V1 140 rajectsYed_blnk|

|

|

|

" Tookhain [ IDE
| SHABTME2

|

[ Unker Settngs
|

Masmum Heap Se 0x 200
Minimum Stack Size Ox400

| 1oy and Prrware Fadkage
Meu Reference
STMIFHTIET

[ use Default Famware Locaton
DetiSTMIZCUbe_FN_F4_¥1.14.0

w | []Generate Under Root

2.8 WARIUTINANG Project Settings TUsunsu STM32CubeMX
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| % STMIRCUbeMX led_blnk.soc™ STMIEAOTITT
Fie Projec Prowt Window Help

Bo8UY &8 Duwotrmwrmnn o » J—@+rm g Q 4 Deewsind @ P
e —— Power Garmemgben Caladakar ) S -

& » AL
% ® DAL
& s bW

STMIZF40TIETX
LOFP144

ERRE RN B

§iid

Seres e
Enaxs ETMIFATAT e
TRy AR
STHAF 07 AT
==

U 2.9 uanawthising Pinout Tusunas STM32CubeMX

3. sialuffunissern Clock Wity McU Terden Input frequency = 8MHz, PLL
Source Mux = HSE, System Clock Mux = PLLCLK LLa:fG%jﬁﬂ'W HCLK = 160MHz wa2n®

Enter

» STMIXC ubehiX Jed blinkioc": STMI2F 40726
e Prvject ClockConfiumen Vingon Hlp

IREATY a8 a5 v08 1
Pt Clock Confouration | Corfiguration | Power Comumplion Caklaior

fla» o4 ) £ i-m-rrpd-jcmq]

HC1K s

-

x T TN [ a)

A -—and-u{lsn‘l
Bk Lana [ e o syt 1
sf v
} —— ,_—-Ol =2 s o N] : FOLK Cortmx elock (Mbs)
PR T e
- - ﬂor- wo b7 ,.ﬁi:;f‘j o EE e AP peripharal siocks (HH2)
| e o

o ;;.EE...._M.[.....,

fp——

R B AR peherst e 1)
o

o —-Ew-d—k(um}
: RE—
-
- -
= —

‘lJ‘ﬁ 2.10 uanantinnng Clock Configuration TUswAsy STM32CubeMX
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a. aelulsinanit Tab Confieuration don GPIO Liiasar GPIO output level = high

[ T X
WuALTUAY

* T
Fée Projec Windom e
BekuR &8 +=1p

Pt Confguraton .

i * Fin Configuration %
© Heddicwares o
58 rATES
[ e detres
Seweh e
'Em Sowrch (rH [ Show oy Mackhed Pins
Eabled

 Periplerais | L L L ——

5U#1 2.11 uanaiidng Pin Configuration 1UsunTa STM32CubeMX

5. e InAeAI 19w Tadn iy Project > Generate Code LitaNN13a314

Code ot lld9auiu SwasTM32 sl

» Code Generation

@ The Code is successfully generated under D:/st/STM32Cube_FW_F4_V1.14.0/Projects/led_blink/led_blink | ‘.

Folder ] | Close
EOPC“ !{

5Ul 2.12 uanmiisne Code Generation TUsunsu STM32CubeMX
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6. 184311 Generate code &2 TiUnalusunsu System Workbench for STM32

d%’ 5 1 s . A
Puan udead1 Workspace lvinsanu Directory 51 Generate code sans

& Workspace Launcher

Select a workspace

Eclipse stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Workspace: | D:\st\STM32Cube_FW_F4 V1.14.0\Projects

[l Use this as the default and do not ask again

3UN 2.13 uansningng Workspace Launcher TUsunsu STM32CubeMX

7. wdnssAn Workspace b T Import project d$7931n STM32CubeMX

11lu Workspace Imﬂﬂﬁﬂﬁmu‘j File > Import tdan General -> Existing Project into

Workspace

o lmport

Select
Create new projects from an archive file or directory.

Select an impoert source:
type filtter ;ir;

e (& General

| _L‘: Archive File

! (2 Bdéting Projects into Workspace
| (3 File System

| [™ Preferences

| > B

|

|

|

£ Install
= Oomph
> Remate Systems
£> RPM
£ Run/Debug
| » & SVN
i > (& Tasks

s i Tasm

@ < Back Next > Finish

&l

!

<

Cancel

U

8. \dan Root directory Tinsafiu Directory #il4 STM32CubeMX @%13 Code Tusi

udiden Project e led_blink iugy

5UT 2.14 uananiiene Import Wsunsy STM32CubeMx
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© Import [m] x

Import Projects.

[y Seme projects cannot be imported because they already exist in the
workspace

(@) Select roct directory: Lgmmaxumﬂ_w.umpmjm | [
O Select archive file: 8
Projects:

[ [)/LcD_DS| VideoMode SingleSutfer (D:s.STMI2Cube FWFAN ~ | [

| O l(D_WVVW7WMQWMuBQM_R_\_';1 s
[ led_blink (D:\s\STM32Cube_FW_F4_V1.14.0\Projects\led_blink |

| O

| [[] STM3240G-EVAL (DAst\STM32Cube FW_FA V1.14.0\Projects\S’

[ [ STM320G-EVAL (DAst\STM32Cube FIWLFA V1. UDWProjectis |
[ 5TM32412G_DISCOVERY (D:\st\STM32Cube_FW_F4_VI.14.0\Prt \

| ] STM324126 DISCOVERY (s STM32Cube FWLF4 V40P,

| Zide .

<3 -_.Z:,'

Options

[JSearch for nested projects

[ Copy projects into workspace:

[[] Hide projects that already exist in the workspace
Working sets

[J Add project to working sets

Sefectn

PO e

g‘dﬁ 2.15 LAAIAUIANY Import Projects Tdsunsy STM32CubeMX

P : v 1Y o s
9. 1518 Import project Wty workspace uda lvinaaeu Debug glagnisadniiiuy
Run -> Debug uanlusunsuazlsisanimiuasad1niu Debug (mandalailatnnue) Tssean

| v v
MCU wag Debugger Tvnsafuniisnldsuuainn OK

& No board found : Define new board or select an existing board X

¢ No board has been f
@ Before lahnchde s 1
Pl‘eaSe create : @ new bos rd or use an uustmg one.

dfforthls pro;ect.

@ Ueﬁne new board O Use eashng board -

Enter iew board name | jed_blink

Select board chip

Select series : -STM?Z?-— E SIS

Selectmcu: | STM3ZFA07ZETy

Select board :
Debug device : | ST-Linkv2 v]
Debug interface : [ JTAG - |

Bt Ve R d R Y

F 1] ]
|- Ok ;Can_cel;

3ﬂ17’i 2.16 LAAIVLNANINSAIATUDTAAIMSU Debug TUsnsu STM32CubeMX
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10. nvimneggnAsuds Tusunsuiae compile source code wagiiy Debug T
nA Resume 5o F8 Wiali MCU Suluauuni naaeauli LED nsewdulaeifiu Code Wl

Tuiardu main fsil L@ Debug giawiwiu LED uuneiv PF10 nzniu

/* Infinite loop */

/* USER CODE BEGIN WHILE */

while (1)

{
/% USER CODE END WHILE */
/* USER CODE BEGIN 3 */
HAL_GPIO_TogglePin(GPIOF, GPIO_PIN_10);
HAL Delay(100) ;

}

/* USER CODE END 3 */

© Debug - led_blink/Application/User/main.c - Eclipse = [m] >

% B oy
g B Modules = O
v & led_blink elf [AcE STM32 Debugging] I Ll SRRl ©
v B led blink.elf Name Type

+@ Thread #1{Running: User Request)t ¥
35 openocd Y
s} C/Ach/SystemWorkbench/plugins/fr.act.mcu.extemaltools.arm-nonewin32_1.74#
£
i

som TN : >

'S v

< s S e D >

) . RV 4 = e — o 2
éafm.c E{‘J \\ 2’]- W = a%“fﬁe = b s ;‘ B8
| ~ =Y <

88 /* USER CODE END WHILE */ f 5 mainh

i':' S e T o stm32fdochalh

::_! £% DAER CHE-ERIN: 3.5 ++ SystemClock_Config(void) : void
55 ++  Emror_Handler{void) - void

EH] HAL GPIO TogglePin(GPIOF, GPIO PIN 107 o8 WX BP0, Frdttwoid] - void

a3 HAL Delay(100): - il o

24 3} @ main{void) : int

as /* USER CODE END 3 */ ® SystemClock_Config{void) : vaid
a6 @ 5 MX_GPIO_Init{veid) : void

97 ) | @ Error_Handler{void) : void

a8 PO / assert_failed{uin/

< > <« SR

A X%k BBE 3 ES~E-0--0

altools.arm- .win32_1.7.0.201602121829/tools/compiler/bin/arm-none-eabi-gdb (7.10.1.20151:
~
Warning: the current language does not match this frame.
v
;) >
Writable | smartinset | 72:1

U 2.17 uanmdiisng Debug TUsunsu STM32CubeMX
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2.3 YATUNISUAAIHE
2.3.1 mM5lla® ULN2003

ledfldlumsdulnannszuags dnasihaasmaodnmdutvuneadnned
(collector) WavinlAlFuussulniigslddmiuvleddu wieledlnsnestuildlunis
viaruveslsiand udelunisdursasuaniua Asiwed ULN2003 iJulediinisluussy
Bunedweiing 7 fa Wunisldnuwmumaudamesdununn aviiesiivuiadnasnn
wagiianududeutiosas fistuuunisinuiuazisasnslunanduguil 2.3.1 Mfuuseduls

[T T 7

gean +30V nszialeinagedalulaaze iy 500 mA Meilusgiuaiuaiunsa lunis
anszualniiveswnassnglidig vanantuddinisdalalantleadiunsssudaunduann

& 3 PRy £y & vl & o Py a g ] Pl
gunsal iws Nilassaaluvaambinmnuesie vialildduivanidunain wusiad
uamaslnnse amulueles uenaintdvaiuisadulalanilaatas (LED) vuaéndeauin

nanale

E‘Uﬁ 2.18 uansaainlnozunsunigluves IC ULNZ2003
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SU 2.19 uansmsvhinL IC ULN2003 Tunnsdiu 7-Segments

2.4 YAUHAING

YALANINARILAY 7-Segments LUuvsuansnaldnd I (Solid-State Drive : SSD) 38

ar

U o/ Qs s b2 Qs al‘al o s i
NUNIDUSERINRARNMAT - NIBNYT ‘lﬂ‘UWQW’J NUNUITDNINIININNITIAINNIUE DA LED (L\ght

Emitting Diode) Tuwuiena wlevirlivasea LED uragmsaaniauiu nagyinlvuanseonin

< s a

v g ¢ o = & ¢ ¢ o o
duiawvsandeuld Wugluvvvesgunsalduanma dadugunsaliominndmiunis

dnanadeyaluwuummwniswuududa Wetoyalowdliunidyy 1alvitauannua

]

SunN77 DuARINADIANNIILNA wuUBAnnsalindd S unaasdiiay uanmadon Fadu

5
L 1/ =

madenlunisuanaumunning Mdugeudintu lagleuanina 7-Segments Toiululagiu
pgunsnangluaudeg Wy wiin1adnea wserindidnnseiind iASesdnlaviiugiunas

fa & o gal =i 5 2w
Qﬂﬂ'ﬁmaLaﬂﬂ'ﬁauﬂaauq WLLﬁﬂ\?’UﬂﬂlﬂﬁLﬂuﬁ?La"U
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7l J‘b FIQURE 3: Seven segmect displey Jamue shiowing
\ 2. armgecoent of segrments.

J1d3450

FIGURE # : Display of decineal digins with & 7-segmeer device,

wana3ULUUYBTIAYEINAY 7 Segments dzgnimienlugudiasy Inalunuidsegdi

JUN 2.20 uaneguUs1aues 7-Segments WALNITHARIHAKUUATNS

]
=

FDUANIHALUY 7 Segments BuUsEnaulUale 7 ddssgnyinnisilanieUniite

= s

az 2 wwaziudueuded 1 Uyl 3 Fu VU NAY LaBEY UYLAAZLYIIYEY 7 Segments A

v oA ) o \ = = = A A |l v oo YY) o
gNo19893NFIENYIAMA A (18) 839G () lae DP (3 #) aziduvan 8 T8 1msusnau

Tailasrunudu

nsuUsuen 7-Segments gunsouviald 4 wuudised

1. wdemrmw1 Common lagludiu Common Anode — 1AaNtpLdrAalfaagiu
Faun udmdue Aeagiunsin Feshlidautuinedne wazludau Common
Cathode - 1 nausiauvziawiBag AUt 10y UdI1BuY Aeagiudiuan Feazili

AUt AREIN

2. wisenuawe Iae. 7-Segment dasiunatsuuin vweiiumiasgiuldauiily

Aouun 0.56 W1 dvwiadnnan wielugniliidenlaoeusie

s o &

3. wdinnudaudiay lu 7 Segment anaslifaauaninanaleiifnagfieiy

lAN15097299598UINE9TU
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4. Wi o duna AT uagddug vielinmsnandweidlimiloutiuluudayyn
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A13197 2.2 588U Absolute geaail T, = 25 °C
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Parameter Maximum Rating Unit
MR MG
Peak Forward Current 80 80 mA
(1/10 Duty Cycle, 0.1ms Pulse Width)
Power Dissipation 75 75 mW
Continuous Forward Current 25 25 mA
Reverse Voltage 5 5 v
Operating Temperature Range -55 °C to +85 °C
Storage Temperature Range -55 °C to +105 °C
IR Reflow Soldering Profile For Lead Free 260 °C
Soldering
A15199 2.3 anuwaenawid T, = 25 °C
Parameter Symbol MR MG Unit Test
Condition
Min. | Typ. | Max. | Min. | Typ. | Max.

Luminous Intensity T 5% 146 51 146 | mcd I,=20mA
Viewing Angle 20172 deg I,=20mA
Dominant Wavelength Ad 630 572 nm I, = 20mA
Spectral Line Half-Width AN 15 15 nm 1= 20mA
Forward Voltage V; A.9 2.3 2.0 23 v 1= 20mA
Reverse Current I, 10 10 LA V=W
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4. Linear regulated power supply

'
= o L [l =

@ a4 a 1o =y =
wsaruliindnlasundsanglnalinivauaziiszdvuseiuldam deae

A o @

wsiwasuluauluanuag AC input dmSunsideunudidnnsedndfiddyiimuauds

o

W&y (linear regulator) 19gnldlunmsssAussiuliiudlilinnmiadosdennuduniuves
wsaiulnidudummuagivan fnupuiiiisannisnszieuuagnsTunulunssuan s

¢ o . ar o o w a a
1A NARIY linear regulator nagyinn1sindauiniunisivavenszud iedndes

o P R "y 2w a i i a w oo e v
LLMaﬁf\nEJIWLLag'Nﬂ?@u:V]L‘UaliF]E]aﬂﬂ':lHLﬂuaumiqﬂﬁ}qﬂﬂiﬂLLﬁLﬂu LL%E%]?EJIWL‘NMUWU?UI@

U

ez dugunsalludesd fURnsuasnmipuinvageu iesniuaunsaufuniouusiu

|
o =l

& oy s 1 v o 1 1 ! ! & % s
dnaliilszauaeld Methaduundairglnnaldsngnldlaetnesnuuuiees a1sazlsu

Y

dnalgadudie 30 Taad 5 weruud unasingiuisietsgniuleedyyranieuen wu

o = e 13 "o &  w d o 4 .
nmsldnufidasnisoawnanuasdteliiluiad (adummaeuniugag)

JUN 2.35 uanquvasingluidaduniunu DC

5. unasanaln AC/DC
Tuednludwmdngndaidu DC luvegiiniaunsgiinnailu AC wifeudasl
gunsaldiu DC uaumnasinsliuuuldmuguiidiewazsiagn aunsavinenldandunmii
Huvislnl AC wie DC Tngludedldmiiautas undsdnelndsznoufeiasSomnszuauazi

\Autszawmiloudsnd Weldauainl DC Bunm rectifier vinuduiasdinhlvinszuariu



35
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310 AC 38 DC llagliddasdinisdnuyas
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7. Programmable power supply
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8. Uninterruptible power supply
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10. Voltage Multiplier
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4.2 79939V LED ( Light Emitting Diode)
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NUCLEO-L432KC NUCLEO-LO11K4 NuMaker-PFM-NUC472
*  Cortax-4d, SN *  Cortoe-MOs, 32MMI *  Cortex-IAGE S43M4r
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s LEDL 1 Low uag Delay 1 Juni
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=& My Programs 1 #ineclude "mbed.h"
|3 Nucleo_blink_led 2
Bn‘ﬂ"n.cpp 3 DigitalOut myled(LED1);
# {g) mbad 4
5 int main{) {
3 while(l) {
7 myled = 1; // LED is ON
8 wait{0.2); // 200 ms
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10 Wadsddelde, // 1 sec
11 o
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£reis TAIWAN OASIS Btz BB

Http:/fwww.taiwanoasis.com.tw

TO-3227BC-MRMGEE
Surface Mount Device LED

Features
. IC compatible.

Compatible with automatic placement equipment.

Compatible with infrared and vapor phase reflow solder process.

<

‘Dual-color type.

* Package in 8mm tape on 7" diameter reel.
Lead-Free Package (According to RoHS).

Package Dimensions

o 1
1,41 2
0,79
| ‘ CATHODE 048 L 1

3
il i%/ | 7 MARK _-L_u;-— JrjE_— é—Fﬁ, i

CATHODE
08 MARK
¥ =
MG MR

G % o %

MG MR R0,25J
Note:
1. All dimensions are in millimeters.
2. Tolerance is £0.1mm unless otherwise noted.
FNEH R ERAE Prepared Date : REV : A Page 1/5

TAIWAN OASIS TECHNOLOGY CO.,LTD 2005/12/16 Prepared by :




rgs TAIWAN OASIS BEealalle=IRDEI =

VI Hitp:/iwww.taiwanoasis.com.tw
Absolute Maximum Ratings at Ta=25C

Maximum Rating

Parameter Unit
MR MG

Peak Forward Current

(1/10 Duty Cycle, 0.1ms Pulse Width) -~ 80 mA
Power Dissipation 75 75 mW
Continuous Forward Current 25 25 mA
Reverse Voltage 58 - 5 V
Operating Temperature Range -55C to +85TC

Storage Temperature Range -55C to+1057C

IR Reflow Soldering Profile For Lead Free Soldering 260°C

Electrical / Optical Characteristics at TA=25C
MR MG
Parameter Symbol Unit | Test Condition
Min. | Typ. | Max. | Min | Typ. | Max.

Luminous Intensity Iv 51 146 | 51 146 mcd 1g=20mA
Viewing Angle 204 140 deg [F=20mA
Dominant Wavelength Mg 630 72 nm [F=20mA
Spectral Line Half-Width VANYN 15 15 nm [F=20mA
Forward Voltage Ve 1.9 2.3 2.0 2.3 V IF=20mA
Reverse Current Ir 10 10 HA Vr=5V
MR A RAE Prepared Date : REV: A Page 2/5

TAIWAN OASIS TECHNOLOGY CO.,LTD

2005/12/16

Prepared by :
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VL7 Hitp:/iwww.taiwanoasis.com.tw

BIN CODE LIST

MR:
Luminous Intensity  Unit: mcd@20mA
Bin Code Min Max
E1 51 66
E2 66 86
E3 86 112
E4 112 146
MG:
Luminous Intensity  Unit: mcd@20mA
Bin Code Min Max
E1 51 66
E2 66 86
E3 86 112
E4 112 146

Tolerance on each Intensity Binis £15%;

Tolerance for each Dominate Wavelength Binis +1nm

MG:
Dominant Wavelength ~ Unit: nm@20mA
Bin Code Min Max
570572 570 572
572574 572 574
574576 574 576
576578 576 578
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Typical Electrical / Optical Characteristics Curves
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Package Dimensions of Tape and Reel (Units: mm)
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Circuit Design of an AC-Powered LED Lamp for both
[1lumination and Data Transmission

Tang-Jen Liu

Abstract—This study optimizes the lighting of 38 LED chips
connected in series with 14 switches to bypass parts of them
according to the alternating voltage level across the LED string.
Furthermore, the illumination produced by the light will not
become unstable while the light is used as binary signals at the
same time, to transmit data by controlling another switch.

I. INTRODUCTION

For wireless communication, light is directional and
therefore suitable for point-to-point connection [1]. Besides,
light cannot penetrate the wall as RF signal does, so it is easy
to block the signal carried by the light leaking from the room,
that helps us to know where the light is and control where the
signal will go. As a result, the signals conveyed in different
rooms using the same light channel will not interfere with
each other. In addition, the technology implemented with light
usually has lower cost and consume lower power as compared
with its counterpart performed by radio frequency [2].

More intensity of the light generated by LED is available. It :

can be varied in digital methods and the change on the

intensity can be also detected by photodiodes. Accordingly, it -

is proper to convert electric signals to optical ones by LED
that facilitates the progress of communications in optical
fibers and free space [1], [3].

Among LED products, AC LED is designed to work with
alternating current directly that makes it convenient to be used
at home and public buildings. However, its light intensity
changes with the sinusoidal voltage level of the AC power it is
supplied. In our daily lives, the LED lamps employed for
illumination, no matter supplied with DC current or AC
current, are not allowed having light intensity flicker like
flames.

In this paper, a circuit working with white-light LED chips
for illumination and optical signal generation is proposed. The
circuit design makes it available to use the wall-mounted AC
power directly as AC LED does [4], [5] and offer smoother
light intensity than that given by AC LED. In the meantime, it
can be also used to transmit data with the light without
disturbing its performance for illumination.

1I. METHOD

A. Lighting optimization

Fig. 1 shows the circuit in an AC LED, with the addition of
a bridge rectifier, the number of the LED chips in an AC LED
can be down to half, as shown in Fig. 2. LED chips on these
two circuits light up only when all of them at the same loop

978-1-5090-2073-7/16/$31.00 ©2016 IEEE

are turn on together. This characteristic causes the lighting to
be interrupted for almost half of the period of the AC power
when its voltage level becomes insufficient to maintain the
lighting. The discontinuity can be diminished further if the
number of the LED chips at the same loop can be adapted to
the voltage level of the AC power. In other words, leading the
alternating current just flows into the LED chips that the
voltage level can just afford them, the lighting will continue
until the voltage level is too low to just activate one LED chip.

LED
X ACline ;
110 V (rms)
60Hz

Fig. 1. Structure of AC LED.

AC Line
©110V (rms) ©
60Hz

Bridge
Rectifier

Fig. 2. A circuit for LED chips to use alternating current directly.
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Fig. 3. Operation for data transmission to keep the light energy emitted
unchanged.
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B. Lighting for both illumination and data transmission

To transmit data with the light for illumination without
disturbing its lighting performance, the light emitted by all
LED chips in Fig. 2, before rising up to its peak, is used to
represent binary data. Moreover, the light emitted by all LED
chips, decreasing from its peak, is then used to compensate for
the light shortened that is used to represent the low-level bits
before the peak of the light intensity, as shown in Fig. 3(a).
This method is to maintain the light energy emitted constant
during all LED chips lighting up (colored in blue). No matter
transmitting data or not, the total light energy is always equal
to that shown in Fig. 3(b). If there is no data to be transmitted,
as shown in Fig. 3(c), the light energy will be distributed
equally in a frequency different from the baud rate used in Fig.
3(a) over the duration that all LED chips light up.

III. CIrRculT DESIGN

To optimize the lighting performance, there are 38 LED
chips connected in series with 14 switches (S| to Sy4) set
beside them, as shown in Fig. 4(a). These switches are
implemented with optocouplers (Fig. 4(b)). Each one is used
to control if the alternating current will bypass the LED chip(s)
parallel with it. The operation of these switches follows the
rule listed in Table 1 that is synchronized with the zero of the
AC power.

Another switch Sp works for data transmission. It stars to
work while switches S; to Si4 all become open. During the
time, the voltage level of the AC power comes to larger ones
and all LED chips light. The data represented with the
stronger light can have better signal-to-noise ratio. The state
of switch Sy is controlled according to the content of the
binary data to be transmitted and then determines if the light is
emitted or not. In addition, switch Sy has to follow the
schemes mentioned in Fig. 3 to keep the light energy emitted
within every half cycle of the AC power unaffected by the
content of the data.

SN
e T
A B A B

(b)
Fig.4. An AC-Powered LED String.

Optocoupler
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TABLEI
OPERATION OF SWITCHES S, TO Sy,
Voltage Level (V) Off-Duty On-Duty
across LED String Switches LED Chips
0 = 4.6 (none) D,

4.6 = 9.2 S D, to D,

92 F—3 13.8 S| to Sz D] to D;

13.8 =1} 18.0 S]IO S;\ D] to D;

18.0 =3 21.6 S to S, D, to Ds
21.6 = 252 SitoSs D, to Dy

25.2 =3 28.8 Sito S D, to D5

288 & 36.0 S)to S, D, to Dg
36.0 = 432 Sl to Sg D] to Dm
432 = 54.0 SitoS, D, to Dy
54.0 =) 68.4 S t0 Sy D; to Dys
68.4 (=13 86.4 S1 to S“ D; to Din)
86.4 = 108.0 Sito Sy, D, to Dy,
108.0 = 136.8 Sito Sy3 D, to D3y
136.8 = 169.7 S] to Sg; D| to D]g

IV. RESULTS

With the operation of switches listed in Table I, the light
intensity produced by the LED string (Fig. 4) almost follows
the sinusoidal variation of the voltage across the string, as
shown in Fig. 5, that was observed by a photodiode (56428,
Hamamatsu). The steep discontinuity on the light intensity
became smoother and more light energy was obtained.

In addition, there was no difference found among the light
energies emitted by the LED string investigated by a luxmeter
(YF-170, Yu-Fung) for transmitting nothing and ASCII codes
from number "0" to "9" when these data were received by a
photodiode and read by a microcontroller.

Voltage (mV)
FS

400 =y, Sy
5 3
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100 5
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1 1 1 1 1 1 1 1 3t
% 5 10 15 30Tt ime)

Fig. 5. Voltage output of a light intensity detector created with a photodiode
(S6428. Hamamatsu). Its variation almost follows the voltage level across the
LED string that comes from 110V/60Hz AC power.
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